
    ImageStar II Help Index

This index lists all of the Help topics available for ImageStar II.    Click on the topic you 
would like to see.
To learn how to use Help, press the F1 key.
Commands

File Menu Opening, saving and printing images
Edit Menu Cutting, copying and pasting images
View Menu Setting image magnification
Transform Menu Changing image shape and size
Process Menu Adjusting image brightness, contrast
Window Menu Managing document windows
Help Menu Getting online help

Tools
Toolbox Selecting tools, colors and shapes

Basics
About Image Types
Converting between Image Types
Working with Selection Areas
Using Cut, Copy and Paste
Monitor and Printer Calibration



File Menu Commands

The commands in the File menu create new image files, save image files or load previously 
saved image files.

New Creates a new image file
Open Opens a file saved on disk
Restore Restores image to last saved version
Close Closes active image file
Close All Closes all open image files
Information Displays file information on active image
Save Saves active image file
Save As Saves active image with new name and file type
Save All Saves all open image files
Acquire Starts up the Scan Module scanning program
Select Source Selects between Twain software drivers
Printer Setup Selects the printer to use for printing
Page Setup Sets options used for printing
Print Prints the active image 
Output Matching Selects monitor used for calibration
Exit Quit the ImageStar II program

Related Topics:
Help Index



Edit Menu Commands

The command in the Edit menu let you Cut, Copy and Paste image information between 
image documents.

Undo Takes back the last edit
Options Turns the Undo function on and off
Cut Cuts selected image area to the clipboard
Copy Copies selected image area to the clipboard
Paste Places clipboard image into active image window
Clear Clears the selected area to the background color
Clear Trims edges of active image
Controls Sets the options used by the Paste command
Pick Up Pattern Selects pattern used by the Fill command
Fill Fills selected area with color or pattern
Select All Selects the entire image for editing
Invert Selection Reverses the selection area in the active image
Discard Selection Removes selection marquee from active image
Leave the Original Controls background under floating images

Related Topics:
Help Index



View Menu Commands

The commands in the View menu control how the image is displayed on the screen.

Fit in Window Scales image to fit in document window
View Scale Increases or decreases image magnification
Show Rulers Places rulers in active image window
Set Ruler Units Sets unit measurement for rulers
Show Toolbox Displays toolbox in ImageStar II work area

Related Topics:
Help Index



Transform Menu Commands

The commands in the Transform menu change the way pixels in an image or selection area 
are oriented in relation to each other. Transform functions are used to create special visual 
effects.

Flip Flips selected image area
Mirror Flips and moves selected image area
Rotate Rotates selected image area by degrees
Free Rotate Rotates selected image area by dragging mouse
Scale Reduces or enlarges selected image area
Free Scale Reduces or enlarges selected image area by dragging mouse
Resolution Sets the number of pixels per inch in active image
Tilt Slants the selected image area
Perspective Gives the selected image area the illusion of depth

Related Topics:
Help Index



Process Menu Commands

ImageStar II lets you enhance your images with a number of image processing commands. 
You can adjust the Brightness/Contrast, Shadow/Highlight and Hue/Saturation, change the 
mapping and apply special filters.

Invert Reverses the colors and brightness levels in active image
Brightness/Contrast Sets the brightness and contrast of active image
Shadow/Highlight Allows adjustment of brightness in specific brightness ranges
Hue/Saturation Sets the color and color intensity of active image
Map Allows direct editing of an image's color/gray map
Filters Add sharpen, blur, noise and other special effects to active image
Convert To Converts the active image to a new image data type
Split to Channel Splits the active True Color image into separate color channels
Merge Merges split channels back into an complete True Color image

Related Topics:
Help Index



Window Menu Commands

The commands in the Window menu are for organizing and arranging document windows 
and icons used by ImageStar II.

Tile Arranges document windows so each one shows
Cascade Arranges the title bars of the document windows
Arrange Icons Arranges icons across bottom of work area
Window List Lists all of the open image files in ImageStar II

Related Topics:
Help Index



Help Menu Commands

The commands in the Help menu are for using the online help provided with ImageStar II.

Contents See the main help index
Search for Help on Press Shift + F1 to search for help by topic
How to Use Help Press F1 for information on using the Help system
About ImageStar II ImageStar II copyright information

Related Topics:
Help Index



Map Submenu

The Commands in the Map submenu let you directly edit the levels in the active image's 
color/gray map.

Optimize Eliminates extremes of light and dark in active image
Equalize Evenly distributes brightness levels
Posterize Reduces the number of color and brightness levels
Adjust Edit the color/gray map of the active image

Related Topics:
Process Menu



Convert To Submenu

The commands in the Convert To submenu convert the active image to a new image data 
type. The newly created image is displayed in a new image window.

24-bit RGB True Color Converts to 24-bit RGB True Color
8-bit Palette-8 Converts to 8-bit Palette-8
8-bit Gray Converts to 8-bit Gray
1-bit Black & White Converts to 1-bit Black & White

Related Topics:
Process Menu



Split Image to Channel Submenu

The commands in the Split Image to Channel submenu divide the active True Color image 
into its separate color components. You can then do further processing or retouching on the
various components.
Each color component is called a channel. Only RGB True Color images can be split into 
channels, because Gray Scale and Black & White image types are composed of only a 
single channel. ImageStar II lets you split an RGB True Color image to RGB, HLS, HSB or 
CMYK channels.
Split channels are represented by gray scale images. You can edit the individual channels, 
but if you want to merge them back together with the Merge command, make sure that the 
size and resolution of the individual channels remain the same. Otherwise they may not 
merge back together correctly.
Four channel types are available: RGB, CMYK, HLS and HSB.

RGB Split to red, green and blue channels
CMYK Split to cyan, magenta, yellow and black channels
HLS Split to hue, lightness and saturation channels
HSB Split to hue, saturation and brightness channels

Related Topics:
Merge
Process Menu



Toolbox

Tools in the Toolbox are used to edit images. Click on the icon of the tool to select it, move 
the cursor to your working image and drag the tool to edit. Some tool icons open a dialog 
box when double-clicked. The dialog box has controls you can use to adjust the settings of 
the tools.
Selection Tools

 Rectangular Selection

 Elliptical Selection

 Lasso Selection

 Bezier Pen

 Magic Wand

 Move Selection
Paint Tools

 Pencil

 Brush

 Line

 Airbrush

 Stamp

 Eraser

 Text

 Fill Can

 Gradient Fill
Special Effects Tools

 Zoom

 Lighten/Darken

 Sharpen



 Blur

 Diffuse
Color and Shape Tools

 Eyedropper

 Color Indicator

 Brush Shape Button

Related Topics:
Help Index



New

The New command is used to create a new file. When you select New, The New dialog box 
appears.
New dialog box
The New dialog box lets you select the type and size of the new image.

Image Type Click on one of the three radio buttons to select between 24-bit True 
Color, 8-bit Grayscale and 1-bit Black and White.

Width Enter the width of the new image in the Width text box.
Height Enter the height of the new image in the Height text box. Select the 

unit of measurement for the Height and Width from the list box.
Resolution Enter the Resolution of the image. Resolution measured in dots per 

inch or dots per millimeter. Choose the units used in the list box.
OK Opens the new image with the current settings.
Cancel Closes the New dialog box.

Related Topics:
Open
Restore
About Image Types



Open 

To open a file saved on disk, select the Open command from the File menu.
Open dialog box
In the Open dialog box, there is a list of files stored in the current disk directory. Click the 
selected file to display it in the File Name box. Click OK to open the file, or Cancel to quit.

File Name To select a file, either click on the file name, or type the file name in 
the File Name box. The file extension names change when "List Files of 
Type" is altered.

Directory Box The directory box lists all files located in the current directory. The file 
extension name specified in "List Files of Type" is appended to each 
file. If there are more files than the directory box can display, click on 
the scroll bar to advance the list.

List Files of Type ImageStar II supports 5 image file types: Aldus TIFF (*.tif), Z-Soft PCX 
(*.pcx), Windows BMP (*.bmp), TARGA (*.tga) and Graphics Interchange
Format (*.gif). 

Directories The directory box displays the current directory name.
Drives You can select another drive by double-clicking on the drive letter in 

the directory box.
OK Opens the selected image.
Cancel Closes the Open dialog box.

Related Topics:
New
Restore
About Image Types



Restore

The Restore command replaces the current version of the image with the last saved version
on disk.
Be careful about using the Restore command if you have made many changes since the file 
was last saved. You may not want to lose all the changes.

Related Topics:
Undo
Save



Close

The Close command closes the currently active image. You will be asked if you want to save
the file if it has not been saved.

Related Topics:
Close All
Exit



Close All

The Close All command closes all the files opened in ImageStar II. If any of the files have 
been changed, you will be asked if you want to save them first before closing.

Related Topics:
CloseExit



Information

The Information command in the File menu allows you to view information about the active 
image file. Click on the desired file to make it active.
Information dialog box
The Information dialog box displays the type and size of the active image file. Click on the 
OK button to close the dialog box.

Related Topics:
Window List
About ImageStar II



Save

The Save command saves any changes made to the currently active image file. The file is 
saved with the same name and file type.
If the file is a new file that has not been saved before, the Save As dialog box opens.

Related Topics:
Close
Save As
Save All
Restore



Save As

Choose the Save As command to save the currently active file with a new name or file type.
If the file is a new file that has not been saved before, the Save As dialog box opens.
Save As dialog box
When you select Save As, the Save As dialog box appears. The screen shows a list of TIFF 
files. Click the selected TIFF file to display it in the File Name box. 

File Name To select a file to save, double-click on it or type the file name in the 
File Name box. The file extension name changes when "List Files of 
Type" is changed.

Directory Box The directory box lists all files located in the current directory. The file 
extension name specified in "Save File as Type" is appended to each 
file. If there are more files than the directory box can display, click on 
the scroll bar to advance the list.

Save File as Type ImageStar II supports 6 image types: Aldus TIFF (*.tif), Z-Soft PCX 
(*.pcx), Windows BMP (*.bmp), TARGA (*.tga), Graphics Interchange 
Format (*.gif) and Encapsulated Postscript (*.eps). 
When saving as another file type, image quality remains the same.
Note: The EPS file type which ImageStar II supports does not 
include .tif meta file description. Therefore when you load the EPS file 
into your application program, it only shows a cross mark with a square
box.

Compression Some image file types permit the option of compression. Compression 
reduces the memory space required to store files without sacrificing 
image quality. Some application programs do not support file 
compression. If you want to share files with applications that do not 
support compression, leave the compress option unchecked.

Calibration Check the Calibration check box to save calibrated images for use with 
other applications that use image files.
Note: To use the Calibration feature, you must first calibrate your 
monitor.

Directories The directory box displays the current directory name.
Drives You may select another drive by dragging the button indicator at the 

right side of the Drives selection.
OK Click on the OK button to save the file.
Cancel Click on the Cancel button to close the dialog box without saving.

Related Topics:
Close
Save All
Restore
Monitor and Printer Calibration



Save All

The Save All command saves all of the changes made to all open files. The files are saved 
with the same names and file types as they originally had.

Related Topics:
Close
Save As



Acquire

The Acquire command is used to activate the Scan Module scanning software. To scan, 
select the Acquire command.
The Acquire command is used to active any Twain compatible hardware driver. If you have 
more than one Twain compatible source, use the Select Source command to choose the 
driver that is activated by the Acquire command.
Note: See your Scan Module manual for information on scanning with your Microtek 
scanner.

Related Topics:
Select Source



Select Source

The Select Source command is used to select between Twain compatible software drivers, 
such as the Scan Module program that controls your Microtek scanner.
After selecting a hardware driver, you can activate that driver with the Acquire command.
Select Source dialog box.
The Select Source dialog box opens when the Select Source command is selected.

Device list Highlight the device you want to use.
Select Click on the Select button to choose the device.
Cancel Click on the Cancel button to close the dialog box

Related Topics:
Acquire



Printer Setup

Choose Printer Setup before printing to choose the printer you will use.
Select the printer from the list and click OK. If you need to change the way the printer 
works, choose the Setup option.
Note: If you experience any trouble setting up your printer to operate with ImageStar II, see
your Microsoft Windows User's Guide for more information, or contact your printer 
manufacturer.

Related Topics:
Print
Page Setup
Output Matching



Page Setup

The Page Setup command lets you set the options used in printing.
Page Setup dialog box
Select Page Setup from the File menu and the Page Setup dialog box appears.

 Printer Type Displays the printer name which you have chosen from the Printer 
Setup command.

Crop marks When checked, four crop marks will be printed at the corners of an 
printed image.

Calibration bars When checked, the calibration bar will be printed. For black and white 
images, the calibration bar consists of 10 square boxes. Each square 
box represents a gray level from 10% to 100%. For color images, it 
prints both the gray level and the color calibration bars. The color 
calibration bar consists of the colors of cyan, magenta, yellow, red, 
green, blue and black.

Calibration Check the Calibration option to apply the calibration bar which you 
have saved in the Microtek Scanner Calibrator application. You can 
leave it unchecked if you prefer to skip the calibration function.

Halftone by printer Some printers support halftoning. If this option is checked the printer 
will do halftoning for you. In most cases, you should leave it 
unchecked. Then ImageStar II will help your printer to produce the 
halftone image. Click the Halftone Screen button to display the 
Halftone Screen dialog box.

Shape Choose a shape for halftoning. The available shapes are: round, ellipse,
square and line.
To reset all settings to the default, click the Default button. To discard 
parameters you have selected, click the cancel button. When you are 
satisfied with the settings, click OK to accept. 

Frequency For a 300 dpi laser printer, the optimal frequency value is 53 lpi. The 
higher the frequency value, the higher the output quality, as long as 
your printing device is a high quality imagesetter. For Linotype 
imagesetters, you may choose a frequency value from 90 lpi up to 150 
lpi. A high frequency value could result in a darker image with 
registration or moire pattern problems. Consult your print shop dealer 
to make sure the frequency value is acceptable for the printing 
equipment they own.

Angle Images are composed of dots. For a black and white image, a 45 
degree angle is standard. Applying 90 may result in a poor image. For a
color image, default screen angles are 105 degrees for cyan, 75 for 
magenta, 90 for yellow and 45 for black. These default values are best 
for reproduction. For a special effect, the screen angles can be changed
at will.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without making 

changes.

Related Topics:
Print



Printer Setup
Output Matching
Monitor and Printer Calibration



Print 

Choose the Print command to print the currently active image on your printer
The Page Setup and Printer Setup commands let you adjust the page and printer settings 
before printing.
Print dialog box
The Print dialog box contains several options.

Scale to fit the page If the Scale to fit the page option is checked, ImageStar II will resize the
image if it exceeds the limit of the printable area. Leaving this option 
unchecked will trim the excessive image areas when printing.

Copies Set the required copies you want. The default is 1. The copy command 
overrides the copy count which is set in the Page Setup command.

OK Print the active    image.
Cancel Close the dialog box without printing.

Related Topics:
Page Setup
Printer Setup
Output Matching
Monitor and Printer Calibration



Output Matching

The Output Matching dialog box lets you select a monitor or printer to have your images 
calibrated to.
Output Matching dialog box
Selecting Output Matching opens up the Output Matching dialog box.

Device list Select the monitor or printer you want from the Device list.
OK Click on OK to accept the output device.
Cancel Click on Cancel to close the dialog box.

Note: You can calibrate your own monitor and printer with the CALIB.EXE program included 
with the Scan Module scanning software. Devices that you calibrate are automatically 
added to the device list in ImageStar II. See the Scan Module manual for details on 
calibrating your output devices.

Related Topics:
Page Setup
Monitor and Printer Calibration



Exit

Choose Exit to quit ImageStar II. ImageStar II will prompt you before closing if you have any
open files that have not been saved.

Related Topics:
Close
Save All



Undo

You can take back the last edit made with the Undo command. After selecting Undo, the 
image is restored to its previous condition.
After using Undo, the command changes to Redo. Select Redo to take back the last Undo 
command. 

Related Topics:
Restore
Options



Option

The commands in the Option submenu let you turn the Undo function on and off.
ImageStar II saves a version of the active image before the last edit was made. Turning off 
Undo will save memory, since the last version is no longer saved. However, you will not be 
able take back the last edit made.
Checking the Undo and Redo commands in the Option submenu turns them on, and 
unchecking turns them off.

Related Topics:
Undo



Cut

The Cut command places the selected areas of the active image onto the clipboard.
If Leave the Original is checked, the underlying image remains intact after a floating image 
is cut. If Leave the Original is unchecked, the cut area is filled with the current background 
color.

Related Topics:
Copy
Paste
Clear
Using Cut, Copy and Paste
Working with Selection Areas



Copy

The Copy command duplicates the selected areas of the active image onto the clipboard. 
When you copy a selection, the selected areas remain intact.

Related Topics:
Cut
Paste
Clear
Using Cut, Copy and Paste
Working with Selection Areas



Paste

When selected areas have been cut or copied to the clipboard, the Paste command is 
available. Choose the Paste command to place the image from the clipboard into your 
working image. For further control of the paste process, use the Controls command in the 
Edit menu.
Note: The Paste command is not available for Palette-8 image type.
You have three methods to paste in the Paste submenu: As Selection, Inside Selection and 
Outside Selection.
As Selection
If you have an area selected when choosing As Selection, the image will paste from the 
upper left corner of your selection area. Without no area selected, it is pasted from the 
upper left corner of the working image.
Inside Selection
When you have an area selected and choose Inside Selection, the clipboard image is pasted
inside the current selection. When you drag the pasted selection, it will not show through in 
areas that are not part of the original selection.
Outside Selection
Selecting Outside Selection when an area is already selected in the active image will paste 
the clipboard image outside the selection area. When you drag the pasted selection, it will 
not show through in the originally selected area.

Related Topics:
Cut
Copy
Controls
Using Cut, Copy and Paste
Working with Selection Areas



Clear

The Clear command erases selected areas. If no area is selected, the Clear command 
erases the whole image. Before clearing the image, a dialog box appears asking if you 
really want to clear the image.
If Leave the Original is checked, the floating image is discarded and the underlying image 
remains intact.

Related Topics:
Cut
Paste
Crop
Working with Selection Areas



Crop

The Crop command lets you remove the outer edge of an image.
To use the Crop command, first use the Rectangular selection tool to create a selection 
marquee. Then use the Crop command to remove the portion of the image outside the 
selection area.
If you add or subtract from the rectangular selection area, the Crop command is disabled.
Expanding an image
When an image has a floating selection which is larger than the image size, the Crop 
command increases the size of the image to equal the size of the floating selection. You can
use this technique with the Scale command to expand the size of an image.

1. Choose Select All.
2. Increase the size of the image with the Scale command in the Transform menu.
3. Select Crop.

Related Topics:
Cut
Clear
Working with Selection Areas



Controls

You can use the Controls command to control the transparency of pasted images and select
a clipboard mode.
Note: You cannot see the effects of the Paste Mode until you have deselected the selection 
area.

Controls dialog box
Selecting the Controls command opens the Controls dialog box.

Paste Mode Select a Paste Mode from the list box.
Normal causes the pasted image to completely cover the original.
Darken Only causes the image to be pasted on in areas where the 
clipboard image is darker than the original.
Lighten Only allows the pasted image to be seen only in areas where 
it is lighter than the original.
Color Only causes only the colors of the clipboard image to be pasted 
into original.

Transparency The Transparency level of the clipboard image can be set from 0 
(opaque) to 99% (mostly transparent). Enter the value in the text box

Clipboard mode The available clipboard modes are Private and Public. Private lets you 
cut and paste images within ImageStar II only. Public allows you cut 
and paste images between other applications in Microsoft Windows.

 OK Click on the OK button to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making 

changes.

Related Topics:
Cut
Copy
Paste
Using Cut, Copy and Paste
Working with Selection Areas



Pick Up Pattern

The Pick Up Pattern command lets you define a selection area as a custom pattern. This 
pattern can then be used with the Fill command.
Only two types of image files can be used with Pick Up Pattern, 24-bit True Color and 8-bit 
Gray-scale. To use other image types, first convert them to True Color or Gray-scale. 
To pick up a pattern:

1. Select an area to be defined as a custom pattern with the Rectangular selection tool.
2. Select the Pick Up Pattern command from the Edit menu to save the current selection

area as a custom pattern.
Note: When you exit ImageStar II at the end of an editing section, the custom pattern is not
saved.

Related Topics:
Fill
Working with Selection Areas



Fill

The Fill command provides several different ways to fill selection areas with colors or 
patterns.
You can use Fill with several different image types, but 24-bit True Color images provide the 
most fill options. The results of the Fill command depend on the image type and the options
you assign to the command.
Before using the Fill command, select an area to be filled. The Fill command is unavailable 
when no area has been selected.
The Fill dialog box with True Color and Grayscale images
The Fill dialog box offers several options to control how the Fill is done.

Fill Mode Fill Mode controls how fill color or fill patterns merge with the selection 
area. Choose one of the four Fill Modes on the Fill Mode drop-down list.
Normal is the default setting in the Fill Mode drop-down list. Normal 
replaces the entire selection area with the new fill color or pattern.
Darken only compares the pixels of the selection area with those in 
the fill color or pattern. If the pixel in the fill color or pattern is darker 
than the one in the selection area, then the pixel in the selection area 
is replaced.
Lighten only compares the pixels of the selection area with those in 
the fill color or pattern. If the pixel in the fill color or pattern is lighter 
than the one in the selection area, then the pixel in the selection area 
is replaced.
Color only (for use with 24-bit True Color) replaces the hue and 
saturation values of the pixels in the selection area with the hue and 
saturation values of the pixels in the fill color or pattern.

Foreground Color Select the foreground option to fill the selected area with the 
foreground color. You can set the foreground color with the Color Picker 
before using the Fill command.

Background Color Select the background option to fill the selected area with the 
background color. You can set the background color with the Color 
Picker before using the Fill command.

Pattern Select the Pattern option to fill the selected area with the current 
pattern. Before using the Pattern option, you need to define a custom 
pattern using the Pick up Pattern command in the Edit menu. If no 
pattern has been created, then the Pattern option is disabled.

Transparency The Transparency setting controls how the pattern or fill color looks 
when applied to the selection area. The higher the Transparency 
setting, the more you can see through the fill color. Enter the value you
want in the text box.

 OK Click on OK to fill the selected area.
Cancel Click on the Cancel button to close the dialog box without filling.

The Fill dialog box with Black & White images
The Pattern and Transparency options are not available for Black & White images.



Mode Choose the mode you want from the Fill Mode drop-down list box.
COPY replaces all the pixels in the selection area with the new fill 
color.
AND turns all colors to white unless both the fill and selection color are
black.
OR turns all colors to black unless both the fill and selection color are 
white.
XOR reverses the pixels in the selection area if the fill color is black. 
When the fill color is white there is no change.

Foreground Color Select this option to fill the selection area with the foreground color.
Background Color Select this option to fill the selection area with the background color.
OK Click on OK to fill the selected area.
Cancel Click on the Cancel button to close the dialog box without filling.

Related Topics:
Pick Up Pattern
Fill Can
Gradient Fill
Working with Selection Areas



Select All

Choose the Select All command to select the entire active image.
You can also select the entire image from the keyboard by pressing Ctrl + A.

Related Topics:
Invert Selection
Discard Selection
Working with Selection Areas



Invert Selection

To invert the current selection area, choose the Invert Selection command. The area outside
the current selection will be selected, and the area inside the current selection will be 
deselected.
You can also invert the current selection from the keyboard by pressing Ctrl + I.

Related Topics:
Select All
Discard Selection
Working with Selection Areas



Discard Selection

The Discard Selection command removes the selection marquee from the active image.
You can also discard the current selection from the keyboard by pressing Ctrl - D. 

Related Topics:
Select All
Invert Selection
Working with Selection Areas



Leave the Original 

When you choose Leave the Original, the image underlying a floating selection area is 
unchanged by editing or dragging the floating selection. When Leave the Original is 
unselected, the underlying image is filled with the current background color if the floating 
image is moved.

Related Topics:
Working with Selection Areas



Fit In Window

You can display the whole image by selecting the Fit in Window command from the View 
menu. The Fit In Window command automatically selects a suitable scaling value among 
the View Scale magnification levels.

Related Topics:
View Scale
Show Rulers
Zoom



View Scale

ImageStar II lets you edit your image documents at different levels of magnification. Select 
one of the View Scale commands from the View Scale submenu to select the magnification. 
Changing the view has no effect on the document.
To select the view scale:

1. Select the View Scale command from View menu. The View Scale submenu shows 19 
levels of magnification. Magnification levels range from 200 to 800%, and reduction 
levels range from 10 to 90%.

2. Choose the level you want your image displayed at.

Related Topics:
Fit in Window
Zoom



Show/Hide Rulers

The Show Rulers command in the View menu turns on the vertical and horizontal rulers in 
the active image window. The rulers let you measure the size of your image document. 
When the rulers are turned on, the command changes to Hide Rulers.
To use the rulers:

1. Select the Show Rulers command from View menu.
2. Both rulers appear at the top and left edges of the image window.

Only the rulers in the active window are turned on.
3. Select the Hide Rulers command from the View menu to turn off the rulers.

Related Topics:
Set Ruler Units
Show Toolbox



Set Ruler Units

The Ruler Unit command allows you to set the unit of measurement for the rulers.
To set the ruler units:

1. Select the Ruler Unit command from the View menu.
The Ruler Unit submenu provides units in inch, centimeter, millimeter and pixels.

2. Select the desired unit of measurement.
This is the unit used for both the horizontal and vertical rulers.

Related Topics:
Show Rulers
Show Toolbox



Show/Hide Toolbox

You can hide the toolbox by selecting the Hide Toolbox command.
When the toolbox is hidden, the Hide Toolbox command changes to the Show Toolbox 
command. Select Show Toolbox to make the toolbox reappear.

Related Topics:
Show Rulers



Flip

The Flip command takes an area and flips it over. The flip can be either horizontal or 
vertical in direction.
To flip your image document:

1. Define an area with a selection tool. If no area is selected, the whole image is flipped.
2. Select the Flip command from the Transform menu.
3. Choose Flip Horizontal to flip the image from side to side.

Choose Flip Vertical to flip the image end over end.
4. The flipped area floats on the original image, allowing you to drag it anywhere on the 

image document. Choose Discard Selection to merge the flipped area with the 
background.

Related Topics:
Mirror
Rotate
Free Rotate
Working with Selection Areas



Mirror

The Mirror command works like the Flip command. The only difference is in the placement 
of the flipped image. With the Mirror command, the flipped area becomes a floating image 
placed to the side of the originally selected area.
To mirror a selection area:

1. You must first select an area with one of the selection tools to enable the Mirror 
command.

2. Select Mirror from the Transform menu.
3. You can mirror the selected area in one of four directions: left, right, top and bottom. 

Choose the one you want.

Related Topics:
Flip
Rotate
Free Rotate
Working with Selection Areas



Rotate

The Rotate command let you rotate the selection area any number of degrees clockwise or 
counterclockwise.
To use the Rotate command:

1. Define the area you want to rotate with one of the selection tools. If no area is 
selected, the Rotate command is disabled.

2. Select the Rotate command from the Transform menu. The Rotate dialog box 
appears.

3. Enter the number of degree you want to rotate the selection in the Angle edit box. 
The degrees of angle can range from 0 to 359.

4. Select the clockwise or counterclockwise direction.
5. Click OK.

To change the orientation of the entire image, use the Rotate and Crop commands together.
1. Choose Select All.
2. Choose Rotate 90 degrees.

Some portion of the image may rotate out of view.
3. Choose the Crop command.

The missing image areas are restored.

Related Topics:
Free Rotate
Scale
Tilt
Perspective
Working with Selection Areas



Free Rotate 

The Free Rotate command lets you rotate the selected area of an image by dragging it.
To use Free Rotate:

1. Before using the Free Rotate command, you need to outline the area you want to 
rotate with one of the selection tools.

2. Select the Free Rotate command from the Transform menu. Black handles appear 
around the bounding box of the selection area.

3. Use the mouse to select one of the handles and drag it in the direction you want the 
selection area to be rotated. The status bar indicates the degree of angle.

4. The bounding box remains active. You can adjust the amount of rotation until you are 
satisfied with the results.

5. When done, click the mouse inside the selection area to end the rotate command. 
The area remains selected. If you click outside the selection, the command ends and 
the selection area is deselected and merged with the background.

Related Topics:
Rotate
Scale
Tilt
Perspective
Working with Selection Areas



Scale

To resize a selection area, use the Scale command. The Scale command allows you to 
enlarge or reduce the width and length of the selection area.
To use the Scale command:

1. To enable the Scale command, you need to outline the area you want to scale with 
one of the selection tools.

2. Select the Scale command from the Transform menu. The Scale dialog box appears.
3. Set the desired measurement for the width and height (the units can be set to inches,

centimeters or pixels).
4. Click OK when done.

Related Topics:
Free Scale
Resolution
Crop
Working with Selection Areas



Free Scale

You can use the mouse to set the scale of the selected area by choosing the Free Scale 
command.
To use the Free Scale command:

1. First select an area with one of the selection tools.
2. Select the Free Scale command from the Transform menu. Black handles appear 

around the bounding box of selection area.
3. Drag the handles to enlarge or reduce the selection area. The bounding box remains 

active to let you continue adjusting the scale.
4. When done, click the mouse inside the selection area to end the Free Scale 

command. The area remains selected. If you click outside the selection, the 
command ends and the selection area is deselected and merged with the 
background.

Related Topics:
Scale
Crop
Resolution
Working with Selection Areas



Resolution

The Resolution command changes the resolution of the image. For example, you may 
change an image from a 2" x 2", 150 dpi to 1" x 1" in size and 300 dpi in resolution. Though
the resolution is changed, the image appears the same until printed.
The Resolution dialog box
Selecting the Resolution command opens the Resolution dialog box.

New Enter the new resolution value in the New text box.
OK Click on the OK button to accept the new resolution value.
Cancel Click on the Cancel button to close the dialog box with making any 

changes.

Related Topics:
Scale
Free Scale



Tilt

Choose the Tilt command to tilt an image or selection area to a new angle.
To use the Tilt command:

1. To enable the Tilt command, you must first outline an area with one of the selection 
tools.

2. Select the Tilt command from the Transform menu. Black handles will appear around 
the bounding box of the selection area.

3. Drag any one of the handles in the direction you want the selection area to be tilted. 
The parallel sides of the selection area tilt in the same direction. The direction of the 
tilt depends on the first move of the mouse. The bounding box with handles remains 
to let you adjust the tilt. You can repeat the Tilt command until you are satisfied.

4. When done, click the mouse inside the selection area to end the Tilt command. If you 
click the mouse outside the selection area, the command ends and the current 
selection area becomes deselected.

Related Topics:
Rotate
Perspective
Working with Selection Areas



Perspective

The Perspective command distorts an image in such a way as to give it the illusion of depth.
To use the Perspective command:

1. To enable the Perspective command, first select an area with any of the selection 
tools.

2. Select the Perspective command from the Transform menu. Black handles appear 
around the bounding box of the selection area.

3. Drag any one of the handles to adjust the perspective. The direction of the 
perspective is determined by the first direction the handle is dragged.

4. The bounding box will remain, allowing you to adjust the perspective again. Click the 
mouse inside the selection area when you are done. Clicking outside the selection 
area deselects the area and merges it with the background.

Related Topics:
Rotate
Scale
Tilt
Working with Selection Areas



Invert

The Invert command reverses the brightness values in the active image or selected area. 
Dark areas become light and light areas become dark.

Related Topics:
Brightness/Contrast
Hue/Saturation
Optimize
Adjust



Brightness/Contrast

To adjust the brightness and contrast of an image, choose the Brightness/Contrast 
command. The brightness and contrast controls in ImageStar II are very similar to the 
brightness and contrast controls on your TV.
The Brightness/Contrast dialog box
Selecting the Brightness/Contrast command opens the Brightness/Contrast dialog box.

Brightness Dragging the scroll bar adjusts the brightness range between -100% 
(darkest) and +100% (brightest). 

Contrast Dragging the scroll bar adjusts the contrast between -100% (least 
contrast) and +100% (most contrast). 

Preview Click on the Preview button to see the effects of the changes.
Reset button Clicking the Reset button restores the brightness and contrast settings 

back to zero.
OK Click on the OK button to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Shadow/Highlight
Hue/Saturation
Adjust



Shadow/Highlight

The Shadow/Highlight command lets you modify the brightness levels of your images in 
specific brightness ranges. From the Process menu, choose the Shadow/Highlight command.
The Adjust Shadow/Highlight dialog box
There are three ranges that you can adjust: shadow (dark areas), midtone (mid-range 
brightness values) and highlight (bright areas).
The background of the Shadow/Highlight controls is a histogram of the image. The 
histogram shows the number of pixels in the image at each brightness value. The black line
in the foreground shows how the Shadow/Highlight command is remapping the brightness 
values in the image.

Handles Drag the handles around the histogram to change the brightness 
values.

Input The Input values below the histogram change when the bottom 
handles are dragged to show the current value of pixel under the 
handle.

Output The Output values change when the handles on the right side are 
dragged. The Output values reflect how the input values are remapped 
to create the new brightness levels.

Channel buttons The Channel buttons let you modify the red, green and blue colors 
separately, or all together.
Only the selected color is changed by dragging the histogram handles.

Preview Clicking the Preview button updates the image to reflect the current 
settings. 

Reset Clicking the Reset button clears all changes you have made.
OK Click on the OK button to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Brightness/Contrast
Hue/Saturation
Adjust



Hue/Saturation

You can change the color and color intensity with the Hue/Saturation command. Hue 
represents color or shade, and saturation represents the intensity and purity of the color. 
The Adjust Hue/Saturation dialog box
Selecting the Hue/Saturation command opens the Hue/Saturation dialog box.

Hue Drag the scroll handle or click on the arrow button to change the hue of
the image.
The range is from -180 degrees to 180 degrees. The degrees refer to 
incremental locations on the HSB color wheel. The default is 0, 
indicating no hue changes.

Saturation Drag the scroll handle , or click on the arrow button to change the 
saturation in the image. The range is from -100% to 100%. Negative 
percentages reduce the color intensity and add more gray, positive 
percentages increase the color intensity and reduce the gray.

Preview Clicking the Preview button updates the image to reflect the current 
settings. 

Reset Clicking the Reset button clears all changes you have made.
OK Click on the OK button to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Brightness/Contrast
Shadow/Highlight
Adjust



Optimize

The Optimize command in the Map submenu can make a surprising improvement in the 
quality of your image. Extremes of light and dark are eliminated, and the remaining 
color/gray levels are distributed evenly across the entire brightness range. This adds 
contrast to your images and generally makes them much clearer.

Related Topics:
Map Commands
Brightness/Contrast
Invert
Filters



Equalize

The Equalize in the Map submenu spreads out the color/gray levels in the image as evenly 
as possible. Depending on the original image, the Equalize command usually causes a 
sharp increase in contrast.

Related Topics:
Map Commands
Brightness/Contrast
Invert
Filters



Posterize 

The Posterize command in the Map submenu reduces the number of color/gray levels in 
your image. The result is the creation of bands in the image that replace smooth contours 
from light to dark areas.
The Posterize command can be used to create special effects. It can also be used to see 
how your image will look if displayed or printed on a device that supports only a limited 
number of color/gray levels.
The Posterize dialog box
Selecting the Posterize command opens the Posterize dialog box.

Number of levels Drag the scroll bar to set the color/gray levels you want in the image. 
The range is from 2 to 256.
In a gray image, each value represents the number of gray levels in 
the image. The fewer the number of levels, the coarser the image will 
be. 
In a color image, the red, green and blue colors contain its color levels 
respectively. Therefore, to a Palette-8 color or a 24-bit RGB True Color 
image, if the number of levels is set as 2, since R/G/B contains 2 levels 
for each, the resulting color numbers are 8 (2x2x2). The number of 
levels, the coarser the color image will be since its number of colors is 
limited.

OK Click on the OK button to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Map Commands
Brightness/Contrast
Invert
Filters



Adjust

To adjust the color and brightness of your images by making changes directly to the 
color/gray map, select the Adjust command in the Map submenu
The Adjust dialog box
In the center of the Adjust dialog box is the brightness map. The line that runs diagonally 
through the map indicates how the color/brightness values in the original image are 
modified. The darker values are on the left and run up to the brighter values on the right. To
change the values directly, drag the pencil over the map.

Input/Output The Input and Output values are displayed by the coordinates. The 
lower left corner is (0,0), and the upper right corner is (255, 255). Input
represents the original brightness value of the pixel, and Output shows 
the new, adjusted value. Drawing a straight line from the upper left 
corner to the lower right corner has the same effect as the Invert 
command.

Map list box Pre-defined map settings can be selected with the Map button. Click on
a map setting from the Map list box to select it.

Segmental The Segmental command divides the map line into segments. To 
change the line, just drag one of the nodes. If the Segmental command
is not checked, the line is controlled by freehand.
The Segmental command is convenient for making changes to levels in
a specific range. For example, if you need to remove extremes of light 
and dark without changing the midtones, you can do so by dragging 
the handles at the ends and leaving the middle segments unchanged.

Smooth With clicking the Smooth button, the map line will be smoothly revised.
If the Segmental option was selected, the Smooth command changes it
as unchecked.

Channel The Channel command lets you set the gamma curve of all the colors 
together (All), or the red, green and blue individually.

Reset The Reset button restores the gamma curve to a straight line for the 
currently active channel.

Invert The Invert command inverts the current curve, creating a negative of 
the original image for the current channel.

Gamma Gamma concerns the brightness of an image, particularly brightness in
the middle range. Generally speaking, if the image is too bright, you 
can set the gamma value lower than 1 to make it darker. If too dark, 
increase the gamma to brighten it. Unlike the Brightness control, which
changes the brightness of an image equally in all brightness ranges, 
the Gamma control has the most effect on the middle range of 
brightness values. Gamma values can be set from 0.01 to 10.0. 

Save You can save the state of the current map by clicking on the Save 
button. The map includes all settings you have made in the Map dialog 
box.

Load Click on the Load button to restore a map setting you have already 
saved with the Save button.

Preview Clicking the Preview button updates the image to reflect the current 
settings. 

OK Click on the OK button to accept the changes.



Cancel Click on the Cancel button to close the dialog box without making any 
changes.

Related Topics:
Map Commands
Brightness/Contrast
Shadow/Highlight
Hue/Saturation



Filters

The Filters enables you to blur, sharpen, enhance edges and remove noise. They also 
permit you to define customized filters.
Select the filter you want from the Filters submenu.
Blur
The Blur command decreases the contrast between adjacent pixels and makes the image 
appear hazy or out of focus.
Blur More
The Blur More command has the same effect as the Blur command, only the results are 
more noticeable.
Sharpen
The Sharpen command does the opposite of the Blur command. The contrast of adjacent 
pixels is increased to make the image appear sharper and more focused.
Sharpen More
The Sharpen More command also increases the contrast of the image, only more so than 
Sharpen.
Enhance Edge
When you use Enhance Edge, ImageStar II finds the areas in the image where the 
brightness levels abruptly change. These areas, most likely the edges of objects, are then 
given even greater contrast.
Find Edge
Find edge increases the contrast at the boundaries of objects, but it doesn't stop there. 
Non-boundary areas are changed to black.
The Find Edge command produces an image that looks much like a coloring book. Only the 
outlines of the original shapes remain.
Remove Noise
In audio recording, noise is the term used to describe the hissing and clicking that can be 
heard on older recordings. In scanning, noise can appear as stray dots, either light or dark, 
which are unrelated to the surrounding dots. Use the Remove Noise command to get rid of 
them.
User-Defined Filter
The User-Defined Filter command lets you create your own image processing filters. The 
value in the dialog box can be positive or negative. For color images, the values are 
weighting of R, G and B; for gray images, the values are weighting of levels of gray.
The User-Defined Filter dialog box contains the algorithm for the Blur command. In the 
process, the original pixel is multiplied by 8, and added to the surrounding values which are
multiplied by 1 respectively. This sum is then divided by 16 and a shift value is added.
For more information on filters, we recommend you reference an image processing text 
book.

Related Topics:
Optimize
Equalize



Posterize
Invert



24-bit RGB True Color

The 24-bit RGB True Color command in the Convert submenu converts the current image to 
the True Color image type.
The converted image is displayed in a new document window.

Related Topics:
Convert To
About Image Types
Converting between Image Types



8-bit Palette-8

The 8-bit Palette-8 command in the Convert submenu converts the current image to the 
Palette-8 image type. The converted image is displayed in a new document window.
Converting Black and White to Palette-8
You cannot directly convert images from Black & White to Palette-8 color. To make the 
conversion, first convert Black & White images to Gray Scale. Next, convert the Gray Scale 
image to RGB True Color. Finally, convert RGB True Color image to palette-8.
Converting RGB to Palette-8 Color
Your 24-bit RGB True Color images can have up to 16.7 million colors. After converting to 
Palette-8, the number of individual colors you can have in a single image drops to only 256.
When you convert RGB true color to Palette-8 color image, the Convert to Palette-8 dialog 
box appears. Two options are available for image modifications: Palette and Error Diffusion.

Palette Option The Palette Option contains two selections for color manipulation: 
Uniform, and Optimize. You can enable or disable the Error Diffusion 
function by clicking on the check box.

Uniform Function Of the 8 bits used to encode each pixel, the Uniform option uses 3 bits 
for red, 3 bits for green and 2 bits for blue. The choice of colors is 
determined by the Uniform.

Optimize Function Unlike the Uniform function, Optimize attempts to match with the 
original colors in the image as closely as possible. When converting to 
Palette-8 color, choose Optimize to get the closest matching results. 
Optimize generally gives a better result than Uniform.

Error Diffusion To improve the look of your converted Palette-8 images, you can use 
the Error Diffusion option when converting from Palette-8 to RGB. Error 
Diffusion provides the most accurate color and brightness.
When the Error Diffusion check box was not checked, the colors in the 
RGB image are converted to the Palette-8 image exactly as they 
appear.

OK Click on the OK button to make the conversion.
Cancel Click on the Cancel button to close the dialog box without making 

changes.

Related Topics:
Convert To
About Image Types
Converting between Image Types



8-bit Grayscale

The 8-bit Grayscale command in the Convert Submenu converts the current image to the 
Grayscale image type. The converted image is displayed in a new document window.
Converting Black and White to Gray Scale
When converting from black and white to grayscale, the original image quality is retained.

Related Topics:
Convert To
About Image Types
Converting between Image Types



1-bit Black & White

The 1-bit Black & White command in the Convert submenu converts the current image to 
the Black & White image type.
The converted image is displayed in a new document window.
Converting RGB to Black and White
If you want to convert an image from RGB True Color to Black & White, first convert the 
image to Gray Scale, and then convert the Gray Scale image to Black & White.
Converting Gray Scale to Black & White
To convert from Gray Scale to Black & White, choose the Convert command and then select 
1-bit Black & White. The Convert to B/W dialog box appears.
The three radio buttons are available for selecting Error Diffusion, Halftone Screen and 
Threshold. The Options button is active only when the Error Diffusion function is unselected.

Error Diffusion Error Diffusion provides the most accurate conversion from Gray Scale 
to Black & White. This option places dots in an apparently random 
manner to simulate the gray levels in the original image.

Halftone Screen Click on Halftone Screen button opens the Halftone Screen dialog box.
Shape option lets you specify the appearance of each dot. The default 
shape is Round. Clicking on the arrow button displays a drop-down list 
box from which you can select a different dot shape. The selections 
are: Round, Elliptical, Square and Line.
Frequency option determines the number of halftone dots. The unit of
measure is lines per inch (lpi). Enter the value that you want in the text
box.
Normally, newspapers use 80 to 100 lpi; general offset color printing 
uses 120 to 133 lpi. Some printers may be not capable of printing if the
frequency exceeds 150 lpi. Consult your printer for the best frequency 
to use for your print production.
The default line frequency is 53 lpi. For a 300 dpi image with a 45 
degree angle, this is usually the best frequency.
Angle determines the arrangement of the halftone dots in an image. 
An angle value is required when converting Gray Scale images to 
halftone Black & White images. The angle is also needed when creating
CMYK color separations. 
To change the angle, highlight the current value and enter new one. 
The default angle is 45 degrees. For a 300 dpi image with a frequency 
53 lpi, the best angle is 45.
For CMYK color separations, the suggested angle values for each color 
are: Cyan 105, Magenta 75, Yellow 90 and 45 for Black.
Angle value 90 degrees is not recommended since it generates poor 
image.

Threshold Option Converting from a Gray Scale image to a Black & White image, you 
need to specify the Threshold Value. The threshold is the brightness 
value used to determine if a gray pixel is converted to black or white. 
Pixels brighter than the threshold are changed to white, and if darker, 
changed to black. Selecting 0 for the threshold changes every pixel to 
white, and 255 changes every pixel to black except the gray level is 



exactly 255.
OK Click on OK to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making 

changes.

Related Topics:
Convert To
About Image Types
Converting between Image Types



RGB

The RGB command in the Split Image to Channel submenu splits the image into red green 
and blue channels. Each grayscale image is labeled r, g or b.
For an RGB true color image, red, green and blue are the three channels used by the video 
monitor to display color images. 

Related Topics:
Split to Channel
Merge
About Image Types



CMYK 

The CMYK command in the Split Image to Channel submenu splits the image into cyan, 
magenta, yellow and black channels. Each grayscale image is labeled c, m, y or k.
Black Generation
Full color printing uses cyan, magenta, yellow and black printed in four layers to produce all
printed colors. Black is rather difficult to produce by overprinting cyan, magenta and yellow,
so it is best to print solid black separately.
The Black Generation level is usually 100%. Any black combination of cyan, magenta and 
yellow will be grouped in the black channel. You may also set another percentage value to 
the black layer. Setting Black Generation to 0 causes all the black dots to be distributed to 
the cyan, magenta and yellow channels. When you do this, black dots are generated by 
overprinting with cyan, magenta and yellow, so the image won't be as dark.

Related Topics:
Split to Channel
Merge
About Image Types



HLS

The HLS command in the Split Image to Channel submenu splits the image into hue, 
saturation and brightness channels. Each grayscale image is labeled h, l or s.
Separating an image into these three channels is very useful for retouching the color or the 
brightness of an image without affecting the other channels.

Related Topics:
Split to Channel
Merge
About Image Types



HSB

The HSB command in the Split Image to Channel submenu splits the image into hue, 
saturation and brightness channels. Each grayscale image is labeled h, s or b.
Like HLS, these three channels can also be used for modifying only the color or brightness 
of an image.

Related Topics:
Split to Channel
Merge
About Image Types



Merge Channels

Images that have been split with the Split Image to Channel command can be merged back 
to a single file by using the Merge Channel command.
To create an RGB 24-bit True Color image from the merged files choose the Merge Channels 
command.
Note: You cannot merge the separate channels of an image back together if either of the 
following has occurred:

1. One of the images is missing.
2. The size of one of the images has changed.

Related Topics:
Split to Channel
About Image Types



Tile

The Tile command arranges and sizes all of the open document windows so that all 
windows can be seen.

Related Topics:
Cascade
Arrange Icons
Window List



Cascade

The Cascade command arranges all of the open document windows so that the title bars of 
each window can be seen.

Related Topics:
Tile
Arrange Icons
Window List



Arrange Icons

The Arrange Icons command arranges all document window icons along the bottom of the 
ImageStar II work area.
If there are no documents icon mode, the Arrange Icons command has no affect.

Related Topics:
Tile
Cascade
Window List



Window List

All open image files are listed in the Window List. Select the image you want by name from 
the Window List to activate it and bring it to the top of the ImageStar II work area.

Related Topics:
Tile
Cascade
Arrange Icons



How to Use Help

To find out more about the Microsoft Windows Help system, press the F1 key anytime.
To get instant help on any ImageStar II menu command:

1. Drag the pointer over a menu command.
2. Press F1.

The help information that appears will apply to the command you have selected.

Related Topics:
Help Index



About ImageStar II

The About ImageStar II command displays copyright and version information on ImageStar 
II.

Related Topics:
Information
Help Index



 Rectangular Selection Tool
Click the Rectangular selection tool icon and drag the tool over the image to create a 
rectangle.
You can add to, or subtract from existing selection areas by holding down the Shift key or 
Ctrl key while dragging the cursor. To draw from the center, hold down the Alt key.
The Rectangular Selection dialog box
Double-clicking on the Rectangular tool icon displays the Rectangle Selection Option dialog 
box.

Options Three options are available: Normal, Ratio and Fixed Size. Choose one 
of the three options from the drop-down menu list.
Normal lets you set the selection area size by dragging the selection 
tool.
Ratio allows you to set the ratio of the sides of the rectangle from 1 to 
10. To select a square, set the aspect ratio to 1 for both the X and Y 
axes.
Fixed Size can be set from 1 pixel up to the size of the image. This 
selection is useful when a specific size is required. If you are uncertain 
of the current image size, you can check find out with the Information 
command in the File menu.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Elliptical Selection
Move Selection
Working with Selection Areas
Using Cut, Copy and Paste



 Elliptical Selection Tool
Click the Elliptical selection tool icon and drag the tool over the image to create an ellipse.
You can add to, or subtract from existing selection areas by holding down the Shift key or 
Ctrl key while dragging the cursor. To draw from the center, hold down the Alt key.
Elliptical Selection dialog box
Double-clicking on the Elliptical tool icon displays the Ellipse Selection Option dialog box.

Options Three options are available: Normal, Ratio and Fixed Size. Choose one 
of the three options from the drop-down menu list.
Normal lets you set the selection area size by dragging the selection 
tool.
Ratio allows you to set the ratio of the sides of the ellipse from 1 to 10.
To select a circle, set the aspect ratio to 1 for both the X and Y axes.
Fixed Size can be set from 1 pixel up to the size of the image. This 
selection is useful when a specific size is required. If you are uncertain 
of the current image size, you can find out with the Information 
command in the File menu.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Rectangular Selection
Move Selection
Working with Selection Areas
Using Cut, Copy and Paste



 Lasso Selection Tool
The Lasso tool lets you select an irregular shape. To use the Lasso, drag it over the image. 
Double-click the mouse button when done.
You can also create a selection area by repeatedly clicking and releasing the mouse button 
as you drag the tool. This creates a series of straight lines. Double-click when done.
You can add to, or subtract from existing selection areas by holding down the Shift key or 
Ctrl key while dragging the cursor. 

Related Topics:
Bezier Pen
Magic Wand
Move Selection
Working with Selection Areas
Using Cut, Copy and Paste



 Bezier Pen Selection
The Bezier Pen tool allows you to create a selection area by repeatedly clicking and 
dragging the mouse. 
Each time you click and release the mouse button, you create a node. Continue creating 
nodes until you have completed the outline of the selection, then double click to end.
You can curve the line from the last node to the current node by dragging the mouse before
releasing the mouse button. This creates a vector handle. Drag the vector handle until the 
line is curved the way you want it. The vector handle remains after releasing the mouse. 
The direction of the vector handles of the last two nodes decides the path of the line to the 
next node. 
Here are the steps to using the Bezier Pen.

1. Click on the Bezier Pen icon, and click on the active image to set the first node.
2. Move the cross cursor to the next position, click and drag at the second node to 

create a curve.
You can continue to select the nodes to build the curves you need.

3. To end your selection, double-click the mouse button anywhere in the working image.
4. You can modify the path before double-clicking the mouse button. Hold down the Alt 

key and move the cursor to a node on your path. The shape of the cursor will then 
change from a cross to a pointer. Drag the node to change the path, or drag one of 
the two vector handles to reshape the curve.

Related Topics:
Lasso Selection
Magic Wand
Move Selection
Working with Selection Areas



 Magic Wand
Some image areas are difficult to select with the Rectangular, Elliptical or Lasso selections. 
The Magic Wand tool helps you select complicated areas in your image. The Magic Wand 
selects an area of adjacent pixels which are similar in color or brightness. Click on the 
image to select an area.
You can add to, or subtract from existing selection areas by holding down the Shift key or 
Ctrl key while dragging the cursor. 
The Magic Wand dialog box
Double-click on the Magic Wand icon to open the Magic Wand Option dialog box.

Tolerance The tolerance value determines how closely neighboring pixels must be
in color to be selected by the Magic Wand tool. A zero value indicates 
that only pixels which are exactly the same are selected. A value of 
255 selects all pixels in the image. The higher the tolerance value, the 
wider the selection areas. The default is 32.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Lasso Selection
Bezier Pen
Move Selection
Working with Selection Areas
Using Cut, Copy and Paste



 Move Selection Tool
The Move Selection tool lets you move the selection area itself without moving the 
contents. Click on the Move Selection tool and drag the selection area in the active image.

Related Topics:
Rectangular Selection
Elliptical Selection
Lasso Selection
Bezier Pen
Magic Wand



 Pencil Tool
Used to draw freehand lines, the pencil tool applies sharp-edged lines drawn in the 
foreground color. The width and style of the Pencil is determined by the setting of the shape
indicator box.
Pencil dialog box
Double-clicking the Pencil icon displays the Pencil dialog box.

Paint Mode Select a Paint Mode from the list box.
Normal causes the color to completely cover the image.
Darken Only causes the color to show only where the color is darker 
than the image.
Lighten Only causes the color to show only where the color is lighter 
than the image.
Color Only sets the Pencil to paint only color, and not the line.

Transparency The Transparency level of the Pencil can be set from 0 (opaque) to 99%
(mostly transparent). Enter the value in the text box

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Brush
Airbrush
Line
Eraser
Color Indicator
Brush Shape Button



 Brush Tool
The Brush Tool paints soft-edged lines in the foreground color. 
Brush tool dialog box
Double-clicking the Brush icon displays the Brush dialog box.

Paint Mode Select a Paint Mode from the list box.
Normal causes the color to completely cover the image.
Darken Only causes the color to show only where the color is darker 
than the image.
Lighten Only causes the color to show only where the color is lighter 
than the image.
Color Only sets the Brush to paint only color, and not the line.

Spacing If your brushing speed is too fast to display the result in real time, the 
spacing option allows you to set a center-to-center distance between 
consecutive dots. You can set the range value from 0 to 16 pixels, 
where 0 indicates the spacing option is the distance between dots, and
16 is the maximum distance.

Transparency The Transparency level of the Brush can be set from 0 (opaque) to 99%
(mostly transparent). Enter the value in the text box

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Pencil
Airbrush
Eraser
Color Indicator
Brush Shape Button



 Line tool
The Line tool is used to draw straight lines in the foreground color. You can set the Line tool 
to draw a soft or hard-edged line. To use the Line Tool, drag the cursor over the image and 
release the mouse button. 
The Line tool command allows you to limit the angle of the line to 15 degree increments by 
holding down the Shift key when creating the line. Doing this you to draw a line with an 
angle in increments of 15 degrees.
The Line Tool dialog box
Double-clicking the Line tool icon displays the Line tool dialog box.

Paint Mode Select a Paint Mode from the list box.
Normal causes the color to completely cover the image.
Darken Only causes the color to show only where the color is darker 
than the image.
Lighten Only causes the color to show only where the color is lighter 
than the image.
Color Only sets the Line Tool to paint only color, and not the line.

Transparency The Transparency level of the Brush can be set from 0 (opaque) to 99%
(mostly transparent). Enter the value in the text box

Soft Edge Check the Soft Edge check box to give the Line tool a soft, rather than 
hard edge.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Pencil
Stamp
Text
Eraser
Color Indicator
Brush Shape Button



 Airbrush Tool
The Airbrush tool sprays color pixels on the working image or selected area. The Airbrush 
produces dots in the current pattern mixed with the working image. To change the pattern, 
click on the shape indicator before selecting the Airbrush.
Airbrush tool dialog box
Double-clicking the Airbrush icon displays the Airbrush dialog box. 

Paint Mode Select a Paint Mode from the list box.
Normal causes the color to completely cover the image.
Darken Only causes the color to show only where the color is darker 
than the image.
Lighten Only causes the color to show only where the color is lighter 
than the image.
Color Only sets the Airbrush to paint only color, and not the line.

Spacing If your brushing speed is too fast to display the result in real time, the 
spacing option allows you to set a center-to-center distance between 
consecutive dots. You can set the range value from 0 to 16 pixels, 
where 0 indicates the spacing option is the distance between dots, and
16 is the maximum distance.

Transparency The Transparency level of the Airbrush can be set from 0 (opaque) to 
99% (mostly transparent). Enter the value in the text box

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Brush
Eraser
Eyedropper
Color Indicator
Brush Shape Button



 Stamp Tool
The Stamp tool is useful for duplicating a portion of an image, and has many more options 
than using the Cut and Paste commands to duplicate image areas.
Follow these steps to use the Stamp tool.

1. Hold down the Shift key and click to set the center point.
This determines the area of the image to be copied.

2. Move the cursor to the position you want to stamp.
3. Drag the mouse to stamp.

The image area is copied to the area you drag the cursor.

Stamp Tool dialog box
Double-click on the Stamp tool icon to open the Stamp tool dialog box.

Stamp Mode Select a Paint Mode from the list box.
Normal causes the color to completely cover the image.
Darken Only causes the color to show only where the color is darker 
than the image.
Lighten Only causes the color to show only where the color is lighter 
than the image.
Color Only sets the Stamp to paint only color, and not the line.

Spacing If your stamping speed is too fast to display the result in real time, the 
spacing option allows you to set a center-to-center distance between 
consecutive dots. You can set the range value from 0 to 16 pixels, 
where 0 indicates the spacing option is the distance between dots, and
16 is the maximum distance.

Transparency The Transparency level of the Stamp tool can be set from 0 (opaque) to
99% (mostly transparent). Enter the value in the text box

Soft Edge When checked, the edge of the stamped image is smoother.
Aligned When unchecked, the stamp copies with reference to the cross center. 

When checked, the reference point moves with the stamping tool.
OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Pencil
Brush
Airbrush



 Eraser Tool
The Eraser tool lets you change the color of pixels in the image to the current background 
color. 
Eraser Tool dialog box
Double-click on the Eraser tool icon to open the Eraser tool dialog box.

Erase Mode Select an Erase Mode from the list box.
Normal causes the background color to completely cover the image.
Darken Only causes the color to show only where the color is darker 
than the image.
Lighten Only causes the color to show only where the color is lighter 
than the image.
Color Only sets the Eraser to paint only color, and not a line.

Spacing The spacing option allows you to set a distance which the Eraser 
delays before it begins erasing. You can set the range from 0 to 16, 
where 0 indicates no delay.

Transparency The Transparency level of the Eraser can be set from 0 (opaque) to 
99% (mostly transparent). Enter the value in the text box

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Pencil
Brush
Color Indicator
Brush Shape Button



 Fill Can Tool
The Fill Can tool fills a selected area in the active image with the current foreground color. 
The status bar shows the coordinates of the pixel currently under the pointer. When you 
click on the image with the Fill tool, the finished percentage is displayed in the status bar.
Note: The Fill Can tool works with 24-bit True Color images only.

Fill Can dialog box.
From the Tool menu, double-click on the tool icon to display the Fill Can option dialog box. 

Tolerance The Tolerance option determines how closely adjacent pixels must be 
in color or brightness to the original pixel selected in order to be filled. 
The first pixel selected determines the base color. If, for example, the 
original pixel has a value of 94 and the Tolerance is set to 40, adjacent 
pixels in the range of 54 to 134 will be filled. Otherwise they will not be
filled. The fill will continue expanding until no more adjacent pixels are 
found inside the tolerance level.

Transparency Transparency can be set from 0 to 99, from completely opaque to 
completely transparent. The higher the transparency value, the more 
you can see through the paint.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Fill
Color Indicator



 Gradient Fill Tool
For color and gray images, the Gradient Fill tool provides a gradient fill effect. A gradient fill 
is one that slowly changes in color or brightness. Gradients can be set to change from 
background color to foreground color, or the other way around. 
Gradient Fill tool dialog box
Double clicking on the Gradient Fill icon opens the Gradient Fill dialog box.
When you have set the required parameters in the Gradient Fill Option dialog box, click OK 
to enter your working image. Click the start point and drag to the end point. Release the 
mouse button and the Gradient Fill command begins to fill the gradient in the selected area.

Fill Color These fill types are available: From foreground to background, from 
background to foreground, custom color and from foreground to image.
These settings control which colors are used in the gradient fill, and 
how they change from one to the other. If you use a custom color fill 
type, you can also set the number of colors.

Fill Mode The four fill modes are listed by name in the drop-down list box. 
Normal means that the gradient fill is applied to the image regardless 
of which colors are used for the fill color or image color. With Darken, 
the fill color only fills the image when the fill color is darker than the 
image color. When Lighten is selected, the fill color only fills the image 
when the fill color is lighter. The Color only selection changes the color 
of the image only, without affecting the brightness levels.

Fill Model You have three choices for fill models. The three models are then used 
along with the other parameters to do the fill. For example, if you 
select Fill Model: RGB and Fill Color: Fore. To Back., the gradient color 
scheme will show colors composed of combinations of red, green and 
blue. The HSB color model is cylindrical in shape. CW and CCW (for 
clockwise and counter-clockwise) determine how the colors in the 
gradient fill change.

Fill Type Three fill types are available: Linear, Elliptical and Rectangular. Linear 
fills in a straight line, elliptical fills in a round pattern and rectangular 
fills in a square pattern.

Mid Point The mid-point percentage determines the transition rate from one color
to the next.

Transparency Transparency can be set from 0 to 99, ranging from solid to completely 
transparent. The higher the transparency value, the more you can see 
through the fill color.

Repeat Times The Repeat setting controls how many times the gradient fill repeats 
the change of colors.

Number of colors This option is effective only when the fill color is custom color. You can 
select up to 8 colors in the color pane.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Fill
Color Indicator



 Lighten/Darken Tool
The Lighten/Darken tool lets you retouch the active image, selectively lightening or 
darkening portions of the image.
Dragging the Lighten/Darken tool over the image lightens the image under the cursor. Hold 
down the Shift key while dragging to darken the image.
Lighten/Darken Tool dialog box
To open the Lighten/Darken dialog box, double-click on the Lighten/Darken tool icon.

Steps Adjust the Steps to set the strength of the Lighten/Darken tool. The 
higher the value, the stronger the effect of the tool.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Diffuse
Sharpen
Blur
Brush Shape Button



 Sharpen Tool
The Sharpen tool increases the contrast between pixels in the image areas you drag it over.
It works the same way as the Sharpen command. The Sharpen tool increases the contrast 
of the color/gray values of neighboring pixels. To increase the sharpening strength of the 
tool, release the mouse button and press it again, then continue dragging.
Sharpen Tool dialog box
To set the controls, double-click on the Sharpen tool icon to display the Sharpen dialog box.

Sharpen Mode Select a Sharpen Mode from the list box.
Normal sharpens all pixels under the cursor equally.
Darken Only sharpens the darker pixels and enhances shadow areas.
Lighten Only sharpens the lighter pixels and enhances highlights.
Color Only sharpens colors more than edge and transition areas.

Spacing The spacing option allows you to set a distance which the Sharpen tool 
delays before it begins sharpening. You can set the range from 0 to 16, 
where 0 indicates no delay.

Weight The Weight setting determines how hard the tool presses down on the 
image. The harder the pressure, the stronger the result. 1 is the 
lightest and 16 is the heaviest. Default spacing is 0, and pen weight is 
8.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Diffuse
Lighten/Darken
Blur
Brush Shape Button



 Blur Tool
The Blur tool reduces the contrast between adjacent pixels, creating a blurring effect. To 
increase the blurring strength of the tool, release the mouse button and press it again.
Blur Tool dialog box
To open the Blur tool dialog box, double-click on the Blur tool icon.

Blur Mode Select a Blur Mode from the list box.
Normal blurs all pixels under the cursor equally.
Darken Only blurs the darker pixels, particularly shadow areas.
Lighten Only blurs the lighter pixels, especially in highlight areas.
Color Only blurs colors more than edge and transition areas.

Spacing The spacing option allows you to set a distance which the Blur tool 
delays before it begins sharpening. You can set the range from 0 to 16, 
where 0 indicates no delay.

Weight The Weight setting determines how hard the tool presses down on the 
image. The harder the pressure, the stronger the result. 1 is the 
lightest and 16 is the heaviest. Default spacing is 0, and pen weight is 
8.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Diffuse
Lighten/Darken
Sharpen
Brush Shape Button



 Diffuse Tool
The Diffuse tool smooths out the distinctions between adjacent pixels. The effect is like 
smearing paint. To increase the strength of the tool, release the mouse button and press it 
again.
Diffuse Tool dialog box
To open the Diffuse tool dialog box, double-click on the Diffuse tool icon.

Diffuse Mode Select a Diffuse Mode from the list box.
Normal blurs all pixels under the cursor equally.
Darken Only blurs the darker pixels, particularly shadow areas.
Lighten Only blurs the lighter pixels, especially in highlight areas.
Color Only blurs colors more than edge and transition areas.

Spacing The spacing option allows you to set a distance which the Diffuse tool 
delays before it begins sharpening. You can set the range from 0 to 16, 
where 0 indicates no delay.

Weight The Weight setting determines how hard the tool presses down on the 
image. The harder the pressure, the stronger the result. 1 is the 
lightest and 16 is the heaviest. Default spacing is 0, and pen weight is 
8.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Lighten/Darken
Sharpen
Blur
Brush Shape Button



 Text Tool
The Text tool lets you type text strings onto the working image. You can specify the name, 
size and style of the font used.
The text is displayed as a selection area while you click in the working image. You can 
move, fill and manipulate the selected text with a number of different tools.
Text Tool dialog box
To open the Text dialog box, double-click on the Text tool icon. 

Input Text Enter the text you want to display in the editing window.
Font Name Select the font you want to use from the list box.
Font Size Select the size of the font from the Font Size list box.
Font Style Click on the Font Style check boxes to set the style the font is 

displayed in. The style can be any combination of bold, italic, underline
and strikethru.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Pencil
Line
Working with Selection Areas



 Eyedropper Tool
The Eyedropper tool lets you select a color from the active image to be used as the 
foreground color.
To use the Eyedropper, select it and click on the active image. The color under the 
Eyedropper becomes the foreground color. To set the background color, hold down the Shift 
key while clicking.

Related Topics:
Color Indicator



 Zoom Tool
The Zoom tool lets you change the magnification the active image is displayed at. To zoom 
in, select the Zoom tool and click on the image. To zoom out, hold down the Shift key when 
clicking.
You can edit images at any magnification. Changing the magnification does not affect the 
image, only the view of the image.
Using the Zoom tool:

1. Click on the Zoom tool icon in the tool palette.
The cursor becomes a magnifier with a plus sign.

2. Move the cursor over the image document and click.
The point you click becomes the center point in the magnified view.

3. You can continue clicking until the image is at the desired magnification level. 
4. Hold down the Shift key and click to reduce the view scale of the image.

The cursor becomes a magnifier with a minus sign.

Related Topics:
View Scale
Fit in Window



 Color Indicator
At the lower left corner of the tool bar is the color indicator. The inner rectangle displays the
foreground color and the outer rectangle shows the background color.
Color Picker dialog box
When editing a 24-bit True Color image, double-clicking either the foreground or 
background color rectangle opens the Color Picker dialog box.
Note: The Color Picker does not support the Palette-8 image type. Convert Palette-8 images
to 24-bit True Color to edit them.
Both the RGB (red, green and blue) and HSB (hue, saturation and brightness) color models 
use three color planes to describe the 16.8 million available colors.
Because three color planes are used, each color model is 3 dimensional. However, the 
screen is only 2 dimensional, so the Color Picker uses a 2 dimensional representation of the 
3 dimensional color space for selecting colors.
The Color Plane selector at the top of the Color Picker lets you set the first dimension of the 
color plane. Click on any of the buttons R, G, B, H, S or B to select the color plane 
dimension, and then drag the triangular slider to the color in the color plane you want. 
Choosing R, G or B sets the color model to RGB, while choosing H, S or B sets the color 
model to HSB.
Once the first dimension of the color plane is selected, the large square in the middle of the
Color Picker lets you see the other two dimensions. Click anywhere in the square to select a 
color.
You can also set the color by entering the RGB or HSB values directly in the text boxes.

New The current color selected is shown in the New box.
Old The original color is shown in the Old box.
CMYK The CMYK channel is for viewing only,and cannot be edited.
OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Gray Picker dialog box
For an 8-bit Grayscale image, clicking the color indicator opens the Gray Picker dialog box. 
You can click on a gray level within the palette plane to select it, or type in the gray level 
index number. 

Gray Enter the gray level you want in the Gray text box.
Old The original color is shown in the Old box.
New The current color is displayed in the New box.
OK Click on OK to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Pattern Picker dialog box
For single-bit Black and White images, double-clicking the color indicator displays the 
Pattern Picker dialog box.

Patterns From the patterns displayed, select one for the foreground or 



background pattern. 
OK Click on OK to accept the changes.
Cancel Click on the Cancel button to close the dialog box without making any 

changes.

Related Topics:
Eyedropper
Brush Shape Button
About Image Types



 Brush Shape Button
The Brush Shape button at the lower right corner of the toolbox is used to set the shape of 
the brush used with the Pencil, Brush, Airbrush and Eraser tools.
Brush Shape dialog box.
Clicking on the Brush Shape button opens the Shapes dialog box.

Shapes Click on a shape to select it.
Custom Click on the Custom button to expand the dialog box and show the 

Custom Shape window. Drag the cursor over the window to draw the 
custom shape.

Load Click on the Load button to open a dialog box where you can load a 
previously saved custom shape.

Save Click on the Save button to open a dialog box that allows you to save 
the current shape for later use.

OK Click on the OK button to accept the settings.
Cancel Click on the Cancel button to close the dialog box without any changes.

Related Topics:
Eyedropper
Color Indicator
Tool Bar



Image types

ImageStar II allows you to edit several image types: 1-bit Black & White, 8-bit Grayscale, 8-
bit Palette-8 color, and 24-bit RGB True Color. The more bits an image type uses to store 
image data, the higher the image quality.
The differences between image types has to do with the amount of information contained in
the image. Image types with less information, such as Black & White and Gray Scale, take 
up less room on disk, but don't have color information. RGB True Color images have the 
most information, but take a lot of disk space and system resources to edit and save.
24-bit Color
In 24-bit color, there are 24 bits which encode the color information for each pixel. The 
number of possible color combinations with 24 bits-per-pixel is very high: 16,777,216!
8-bit Palette-8 Color
This image type is also known as indexed-256 color. The 256 colors in an individual 8-Bit 
Palette-8 Color image are selected from among 16.7 million colors in the color spectrum. To 
see all the colors, you must have a VGA or SVGA monitor and graphics card that supports 
256 colors. Not all editing tools are available for this image type, so you may want to 
convert these images to True Color for editing.
8-bit Gray
Each pixel is represented by 8-bits, which provides 256 shades of grays. 8-Bit Gray images 
can come from a grayscale or color scanner, or be converted from other image types.
1-bit Black & White
In Black & White mode, each pixel represents either black or white.

Editing Capabilities
ImageStar II's editing capabilities depend on the image type. For 24-bit True Color and 8-bit 
gray, every feature is available. Not all features are supported for the other image types. 

True Color Palette-8 Gray B/W
Bits/pixel: 24 8 8 1
Colors: 16.7 million 256 256 2
Channels: 3 1 1 1
Editing tools: All Limited All Limited

Note: To display color images, you need an appropriate monitor and graphics adaptor.

Related Topics:
Converting between Image Types



Converting between Image Types 

Different application programs require specific image file formats. ImageStar II provides a 
number of file types that can be used with various applications. From Black & White and 
Gray Scale to 24-bit RGB True color image, with ImageStar II you can create image files 
types and formats compatible with most application.
File conversion
ImageStar II allows you to convert images from one image data type to another. In the 
Process Menu, select the Convert to command to convert the active image file. 
Here are some tips for converting files.

-- Converting from black and white to grayscale does not improve the quality of the 
original image, but it does allow you to edit the file.

-- Converting from Palette-8 image to RGB True Color makes all of the image editing 
functions available.

-- When gray scale images are converted to RGB True color, the appearance of the file 
is not changed.

-- When converting from RGB True color to Palette-8, there is a loss of color, although 
this will not be noticeable unless you have a 24-bit color monitor.

Related Topics:
About Image Types



Working with Selection Areas

ImageStar II lets you select areas of your working image to be edited. All image retouching 
functions are applied within selection boundaries. Unselected areas are not affected. 
Selected areas can be cut, copied or cleared.
Making Selections
You can use any of the selection tools to specify part of an image for editing. The editing 
functions include the Cut, Copy and Paste commands.
You can select all or part of an image. When applying an editing command, only the 
selected area is changed. If no area is selected, the entire image is affected by the editing 
command.
The tool palette has several selection tools, such as the Rectangular, Elliptical, Lasso, Bezier
pen and Magic Wand. Selection areas can be expanded or reduced with the Addition and 
Subtraction commands. Also, you can also choose Select All, Invert Selection and Discard 
Selection from the Edit menu to modify a selection area.
Floating selections
When you choose a selection tool and drag it within a selection area, the dragged selection 
area becomes floating. An area is said to be floating when dragging or editing the selected 
area has no effect on the image under it. Other ways area can becoming floating are by the 
using Transformation and Paste commands.
To remove floating selections, you can use the Clear command to discard it, Cut to move it 
to the clipboard, or you can deselect it to cause it to merge with the rest of the image.
Modifying Selections
When you use a selection tool to create a selection area, any previously selected area is 
deselected. You can add to a selection area by holding down the Shift key and using any 
one of the selection tools. The previously selected area remains selected, and the newly 
selected area is added to it. Holding down the Ctrl key while using a selection tool allows 
you to subtract part of the currently selected area.
Double-clicking the icon for some of the selection tools displays a dialog box you can use to 
adjust the way the tool functions.
Keyboard commands
The effects of the selection tools can be modified by holding down certain keys while 
selecting an area.

Alt + Mouse drag: Create selection from center 
Shift + Mouse drag: Add to existing selection
Ctrl + Mouse drag: Subtract from existing selection

Related Topics:
Tool Bar
Using Cut, Copy and Paste



Using Cut, Copy and Paste

The Cut, Copy and Paste commands in the Edit menu allow you to move image data from 
one image to another.
The clipboard is the temporary holding area for image data being transferred from one 
image document window to another. Cut and Copy move image data to the clipboard, and 
the Paste command places the image data currently on the clipboard into the active image.
The image data on the clipboard is temporary. Using the Cut and Copy commands 
overwrites any old image data with new data. However, the Paste command has no effect 
on the clipboard contents.

Related Topics:
Tool Bar
Working with Selection Areas



Calibration

Using ImageStar II and the Scan Module scanning software, you can maintain the original 
color and brightness values in your images as they go from scanner to monitor to printer. 
Calibrating from scanner to monitor
Before going through the following steps, make sure you have first calibrated your monitor. 
See the Scan Module User Guide for details on monitor calibration.
After calibrating your monitor:

1. Choose the Acquire function from the File menu.
The Microtek Scanner Settings dialog box is displayed.

2. Click on the More Options button and select Output Matching System.
The Output Matching System dialog box opens.

3. Select your monitor from the list box.
4. Click on the OK button.

Calibrating from monitor to printer
Before going through the following steps, make sure you have first calibrated your printer. 
See the Scan Module User Guide for details on printer calibration.
After calibrating your printer:

1. Scan in an image.
2. Complete any editing you want to do on the image.
3. Choose the Output Matching System command from the File menu.

The Output Matching System dialog box is displayed.
4. Select the device you calibrated with the Microtek Calibrator. 
5. Make sure Calibration is checked in the Save As dialog box to save calibrated files for 

other applications.
6. Check the Calibration box in the Page Setup dialog box for printing.

Related Topics:
Output Matching


